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1 Introduction 

 

The ARTA is a program for impulse response measurement, real-time spectrum analysis and  real-

time measurement of the frequency response. It is a tool for acoustical measurements and "point to 

point" testing of the audio quality in communication systems. 

 

 

The ARTA has functions of following measurement systems: 

 

1. Impulse response measurement system with signal generators: periodic white noise, periodic 

pink noise, MLS, linear and logarithmic swept-sine. 

2. Dual channel Fourier analyzer with signal generators: white noise, pink noise, periodic white 

noise and periodic pink noise. 

3. Single channel Fourier analyzer with signal generators: periodic white noise and periodic pink 

noise. 

4. Spectrum, octave band and THD analyzer with signal generators: sine, two sine, multitone, 

white noise, pink noise, periodic white noise and periodic pink noise. 

5. Triggered storage scope with gated spectrum analysis and short-time Fourier transform. 

6. Two-channel voltage level meter and third octave analyzer. 

 

Note: Mode 2 and 3 can be also used for the estimation of the impulse response. 

 

With calibrated microphone, ARTA can be used as virtual IEC class 1 SPL meter with real time 

modes: 

 

1. Integrating SPL meter with 24 hours data logging, 

2. Octave SPL meter with noise rating (NR, NC, PNC, RC, NCB), 

3. Third octave SPL meter with report of specific loudness, loudness in sone and loudness level 

in phone. 

The ARTA is also a powerful analyzer of: 

1. Gated frequency response, 

2. Smoothed frequency response (in 1/n-octave bands), 

3. Step response, 

4. Impulse response envelope (ETC ï curve), 

5. Cumulative spectrum  and burst decay waterfall curves and sonograms,  

6. Energy decay in reverberant environments, 

7. Room acoustical parameters  

8. Speech intelligibility measures: MTF, STI, RASTI, %AL. 

9. Loudspeaker directivity pattern 
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1.1 Requirements 
 

 

Requirements to use ARTA software are: 
 

¶ Operating systems: Windows  2000 / XP / Vista / 7 ï 32 bit  

¶ Processor class Pentium, clock frequency 600 MHz or higher, memory 256MB for Windows 

2000/XP or 2MB for Vista/Windows 7 

¶ Full duplex soundcard with synchronous clock for AD and DA converters  

¶ WDM or ASIO soundcard driver (ASIO is trademark and software of Steinberg Media 

Technologies GmbH). 

 

The installation of this software is simple: Take the ARTA setup program or just copy the files 

"ARTA.exe" and "ARTA.chm" to some folder and make a shortcut to "ARTA.exe". All registry data 

will be saved automatically at the first program execution.  

 

Files with extension ".PIR" are registered to be opened with ARTA.  They contain the data of the 

periodic impulse response (PIR) or signal time record.  Results of other types of measurements 

(frequency response and spectrum) may be saved in ASCII formatted file, or as an overlay file.  

 

ARTA can export and import file in various formats (.wav, .tim and .txt). 

 

The ARTA does not dump graphs to the printer, instead of this all graphs could be copied to the 

Clipboard and pasted to other Windows applications.    

 

1.1.1 Soundcards 

The ARTA has been used successfully with a following soundcards:  

¶ RME Fireface 800, RME Fireface 400, RME DIGI96, RME HDSP 

¶ Duran Audio D-Audio, EMU 1616m, EMU 0404 USB, EMU Tracker 

¶ Echo Gina24, Echo AudioFire 4, Echo Layla 24, Echo Indigo 

¶ M-audio Audiophile 2496, Firewire Solo, USB Transit, Delta 44,  

¶ Terratec EWX 24/96, Firewire FW X24  

¶ YAMAHA GO46, Sound Devices USBPre2 

¶ Digigram VxPocket 440 - a notebook PCMCIA card  

¶ TASCAM US-122 - USB audio  

¶ ESI Quatafire 610, Juli,  U24 USB and Waveterminal,  

¶ Soundblaster X-Fi, Infrasonic Quartet 

¶ Soundblaster Live 24, Audigy ZS,  Extigy-USB (but only at 48kHz sampling frequency),  
¶ Turtle Beach Pinnacle and Fuji cards,  

 The ARTA may be used with slightly degraded performance with following soundcards:   

¶ Soundblaster MP3+ USB (notice: don't install SB driver, use a Windows XP default driver),  

¶ Soundcards and on-board audio with AC97 codecs.  

Soundcards are classified into three groups: 

¶ standard sound systems that are incorporated in the computer motherboard,  

¶ add-on sound cards for PCI or ISA bus,  

¶ sound systems that connects to the computer USB or Firewire interface.  
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Depending of the target user group, soundcards differs in type of input/output connectors and 

necessary cabling. Basic characteristics of connectors and cabling are given in Table 1.1.  

 

 

 

¶ Standard PC soundcards uses stereo cables and mini-TSR connectors (Fig. 1.1). 

¶ Semi-professional high quality soundcards use RCA chinch connectors and unbalanced 

connections (Fig. 1.2). 

¶ Professional soundcards use TSR 6.3 mm connectors for balanced connection,  TS 6.3 mm 

connectors for unbalanced connection, and XLR (Cannon) connectors for balanced 

microphone connections (Fig 1.3). 

 

 

 

XLR- female XLR ï male TSR 6,3mm  and 

mini TSR 3,5mm 

TS 6,3mm and 

mini TSR 3,5mm 

RCA chinch 

   
 

 

pin1 ï ground 

pin 2 - plus  

pin 3- minus  

pin1 - ground 

pin 2 - plus  

pin 3- minus 

T (tip) - plus 

R (ring) - minus  

S (sleeve) - ground 

T (tip) ï plus 

S (sleeve) - ground 

pin - plus 

guard - ground 

balanced 

microphone cables 

balanced 

microphone cables 

balanced  cables or 

unbalanced stereo 

cables 

unbalanced  cables 

(coaxial cable) 

unbalanced  

cables 

(coaxial cable) 

 

Table 1.1 Connectors and cables used in audio systems 

 

 

 

 

 

 

 

1. Line-In (light blue) 

2. Line-Out ï Front speaker (green) 

3. Mic In - Mono microphone (pink) 

4. Out ï Central speaker and Sub-bas  

(orange) 

5. Out-Back speaker (black) 

6. Out ï Side speaker (grey) 

 

 
 

Figure 1.1 Audio connectors on the PC motherboard (example for 5+1 surround sound system). 

 

Standard PC stereo systems have three connectors (1, 2, and 3 on the motherboard).  Surround 5+1 

sound systems have additional three connectors (4, 5, and 6 on motherboard). One of outputs is 

designed to drive a headphone with nominal 32W  impedance. For soundcard testing we will use 

loopback connection of Line-In (blue) and Line-Out (green) using stereo cable terminated with mini-

jack TSR connectors. Input impedance of Line-In input on most PC soundcards is 10-20kW. 
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On laptops and notebooks, usually there are only headphone output and microphone input. Those 

systems are not appropriate for use with ARTA, as they cannot enable measurements in dual-channel 

mode because microphone input is a mono channel. 

 

 

 

 

 
 

 

Figure 1.2 PCI card with RCA chinch connectors (i.e. Terratec EWX24/96 or M-Audio Audiophile 

24/96).  There are separate connectors for left channel (in white color) and for right channel (in red 

color).  

 

 

 

 

 
 

 

 

  
 

Figure 1.3 Professional sound system with Firewire interface, TRS and XLR connectors 

 

Fig. 1.3 shows an example of the high quality Firewire professional sound system.  On the front panel, 

there are two XLR microphone inputs. In the center of the XLR connector, a TS connector is inserted. 

It serves as music instrument input.  Input impedance of instrument input is from 470kW to 1MW. 

Both inputs have volume control. Microphone inputs can be switched to phantom power, which gives 

power supply of 48V to pins 2 and 3 of XLR microphone connector. Next, there is a master volume 

control for adjusting output level and input monitor level. Finally, there is a headphone volume control 

and a headphone stereo TSR connector. On the back panel, there are two balanced inputs, two 

balanced outputs, SPDIF optical connectors and two Firewire connectors.  
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1.2 Measurement Setup 
 

In this document, we refer to following measurement setups: 

 

1. Dual channel measurement setup 

2. Single channel measurement setup 

3. Semi dual channel measurement setup 

4. Loopback for soundcard testing 

 

A general measurement setup for system testing is shown in Fig. 1.4. The soundcard left line-output 

channel is used as a signal generator output. The left line-input is used for recording a D.U.T. output 

voltage and the right line-input is used for recording a D.U.T. input voltage. In a single channel setup, 

only a D.U.T. output voltage is recorded.  In a semi dual channel setup the right line-input is used to 

measures the right line-output voltage. In a loopback setup, the left line-output is connected to the left 

line-input and the right line-output is connected to the right line-input. 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1.4 General measurement 

setup for system response testing 

(D.U.T = device under test) 

 

 

 

Setups for acoustical measurements are shown in figures 1.5, 1.6, 1.7 and 1.8. 

 

 

 

 

 

 

 

 

 

 

 

Figure 1.5 Dual channel 

measurement setup for 

acoustical measurements 

 

 

 

To protect the soundcard input from high voltage that is generated by the power amplifier, it is 

recommended to use a voltage probe circuit, as shown in Fig. 1.6. Values of resistors R1 and R2 have 

to be chosen for arbitrary attenuation (i.e. R1=8200 and R2=910 ohms gives probe with -20.7dB  

(0.0923) attenuation if the soundcard has usual input impedance - 10k̔ ).  
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Figure 1.6 Voltage probe with 

soundcard input channel 

overload protection 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1.7 Single channel 

measurement setup for acoustical 

measurements 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1.8 Semi-dual channel 

measurement setup for 

acoustical measurements 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1.9 Loopback setup for 

soundcard testing 
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The ARTA is also targeted for "point-to-point" testing of audio quality in communication systems. 

Figure 1.10 shows setup for testing such systems. Interface to mobile phones can be realized by using 

a headset I/O. Interface to the standard phone line (POTS) is shown in Fig. 1.11.  

 

The ARTA can measure frequency and impulse response, distortions of sine, two-sine and multitone 

signals, estimate delays, echoes and speech transmission index. A special measurement technique, 

with an interrupted noise excitation, is applied to circumvent time-variant behavior of these systems 

(automatic gain control, noise reduction, voice activation). 

 

 
 

Figure 1.10 Measurement setup for testing communication systems 

 

 

 
 

Figure 1.11 Interface from the soundcard I/O to the standard phone line (POTS)  
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1.3 A First Touch 
 

When you start the ARTA you will see the program window as shown in Figure 1.12. This window is 

called Impulse response window (Imp window).  It will be primary used to show the impulse response, 

also it will be used to show the time record of captured signals.  
 
 

 
 

Figure 1.12 Impulse response window 
 

By using the menu Mode, you can switch to three frequency domain windows for the real-time 

analysis: 
 

¶ Dual channel frequency response measurement window  

¶ Single channel frequency response measurement window  

¶ Spectrum analyzer window  
 
 

The measurement mode may be chosen also by clicking following toolbar icons: 

 

FR2 - Dual channel frequency response measurement window  

FR1 - Single channel frequency response measurement window 

SPA - Spectrum analyzer window 

IMP - Impulse response / Signal recording window 

 
 

Now click these menus or toolbar icons to see how the measurement windows are working.  
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Figure 1.13 Dual-channel frequency response window - FR2 (the single channel frequency response 

window - FR1 looks the same)  

 

 
 

Figure 1.14 Spectrum analyzer window  
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The Impulse response window is most important for a system response analysis. It will be described in 

more detail after we show how to analyze the spectrum and the system frequency response. 

 

1.4 Hardware Setup 
 

Before you start measuring you have to setup your hardware and audio devices by clicking the menu 

Setup->AudioDevices or by clicking the toolbar icon  . You will get the dialog box for the audio 

devices setup shown in the Fig. 1.15. 
 
   

 
Figure 1.15 Dialog box for audio devices setup 

 

The 'Audio Device Setup' dialog box has following controls: 
 

 

In section Sound Card:  

 

Soundcard driver  - chooses the type of soundcard driver (WDM ï windows multimedia driver or one of 

installed ASIO drivers).   
Input channels - chooses the soundcard input stereo channels. ASIO driver can have large number of 

channels. 
Output Device - chooses the soundcard output stereo channels.  

Generally, user chooses input and output channels of the same soundcard (mandatory in ASIO driver 

mode).  
Control panel button ï if WDM driver is chosen, it opens sound mixer on Windows 2000/XP or Sound 

control panel in Vista/Win7. If ASIO driver is chosen, it opens ASIO control panel. 

Wave format ï on Windows 2000/XP chooses Windows wave format: 16 bit, 24 bit, 32 bit or Float.  Float 

means IEEE floating point single precision 32-bit format. It is recommended to use 24-bit or 32-bit modes 

when using a high quality soundcard (many soundcards are declared as 24-bit, but their real bit-resolution 

is less than 16-bits).  On Windows Vista / Windows 7 it is recommended to choose resolution type Float. 
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This control has no effect in the ASIO mode, where a bit resolution has to be setup in the ASIO control 

panel. 

 
In section I/O amplifier interface:  

 
LineIn sensitivity  - enters the sensitivity of the line input (i.e. peak voltage in mV that corresponds to the 

full excitation of the line input). 
LineOut sensitivity - enters the sensitivity of the left line output (i.e. peak voltage in mV that corresponds 

to the full excitation of the line output).  
Ext. preamp gain - If you connect a preamplifier or voltage probe to the line inputs you should enter the 

gain of the preamplifier or probe attenuation in the edit box, otherwise set it to unity gain.  
LR channel diff. - enters the difference between the level of the left and the right input channels in dB.   
Power amplifier gain - If you connect the power amplifier to the line-output, and if you need, calibrated 

results in single channel setup, you have to enter the power amplifier voltage gain.  

  
The best way to enter these values is to follow the calibration procedure as described in the next chapter. 

 
In section Microphone:  

Sensitivity - enters the sensitivity of the microphone in mV/Pa.   

Microphone used - check box if you use the microphone and want the plot to be scaled in dB re 20 P̧a or 

dB re 1Pa. Also, use combo box to choose the channel where the microphone is connected (we strongly 

recommend to use the soundcard left channel as the microphone input channel). 

 
The setup data may be saved and loaded, by pressing the buttons 'Save setup' and 'Load setup'. The setup-files 

have the extension '.cal' 

 
 
 

Important notice: Please mute the line and microphone channels at the output mixer of 

the soundcard; otherwise, you might have a positive feedback during measurements. If 

you use a professional audio soundcard, switch off the direct or zero-latency monitoring 

of the line inputs. 

 
 

1.4.1 Windows 2000 / XP WDM driver setup 

After selection of the soundcard user has to disable (mute) line-in and microphone inputs in output 

mixer. In addition, user has to select which input will be used for recording: Line In or Microphone 

(Mic). For a standard PC soundcards, the procedure is as follows: 

 

1) In ARTA Audio device setup dialog click the button óControl panelô to open the 

Windows óMaster Volumeô dialog box, which is shown on Fig. 1.17.  

2) Click on menu óOptions->Propertyô and select soundcard channel that will be used 

for output (playback), as shown in Fig. 1.17. 

3) Mute Line In and Mic channels in dialog óMaster Volumeô (Fig. 1.16). 

4) Set Master Volume and Wave Out volume to maximum.  

5) Click on menu óOption->Propertyô and select soundcard channel that will be used 

for input and enable Line In and Mic channels in recording mixer. 

6) Choose Line In or Mic Input. Normally, ARTA uses Line In input on which external 

microphone amplifier should be connected.  

7) Set volume control of Line In to some lower position. Later it will be set more 

precisely.    
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Figure 1.16 Dialog for choosing soundcard and input/output channels  

 

 

 
 

Figure 1.17 Typical setup of a soundcard output mixer in Windows XP 

 

 

Note: Most professional audio soundcards have their own program for adjustment of input and 

output channel, or have hardware control of input monitoring, and input and output volume 

controls. 
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1.4.2  Vista / Windows 7 WDM driver setup 

 

Microsoft has changed their approach in control of sound devices in Vista / Win7. Now operating 

system (also, sometimes in conjunction with control programs of professional soundcards) is 

responsible for setting soundcard native sampling rate and bit resolution.  Operating system changes 

native resolution to floating point format for high quality mixing and eventually for the sample rate 

conversion. 

For ARTA this means that it is strongly recommended to use resolution óFloatô and set the sampling 

rate to the native format. Access to these values is in óWindows sound control panelô, which user 

gets by clicking on button óControl Panelô in óAudio Device Setupô dialog. 

  

Fig. 1.18 shows Vista/Win 7 control panel, that has four property pages. 

As first step, user has to adjust Playback page and later repeat the same procedure for 'Recording' 

page. Adjustment steps are: 

 

1) Click on channel info to choose the playback channel. It is not recommended  to use the 

measurement channel as a default audio channel.  

2) Click on button óPropertiesô to opens channel óSound propertiesô dialog. 

3) Click on the tab óLevelsô to open the output mixer (as in Fig. 1.16).  Then mute Line In and 

Mic channels, if exist. 

4) Click on the tab óAdvanced' to set the channel resolution and a sample rate (as in Fig. 1.17) 

5) Repeat previous procedure 1) to 4) for recoding channel, and choose the same sampling rate as 

in the playback channel. 

  

 

 

 
 

Figure 1.18 Vista Sound Control panel 

 

 



ARTA User Manual 

 17 

 
 

Figure 1.19 Playback channel properties ï Output levels 

 

 

 
 

Figure 1.20 Setting the native bit resolution and sampling rate in Vista 
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Note: Many drivers do not work stable under Windows 7. In that case, please use ASIO driver if it is 

available for your soundcard. 

1.4.3 ASIO driver setup 

 

ASIO drivers are decoupled from the operating system control. They have their own control panel to 

adjust native resolution and memory buffer size.  The buffer is used for the transfer of sampled data 

from the driver to the user program. User opens the ASIO control panel by clicking button óControl 

Panelô in the ARTA óAudio Device Setupô dialog. Fig. 1.21 shows an example of ASIO control panel. 

 

 
 

Figure 1.21 E-MU Tracker Pre ASIO Control panel for setting bit-resolution and buffer size   

 

In music applications user usually sets buffer size as small as it is possible for stable work. That gives 

the lowest input/output latency (system-introduced delay).  

In ARTA, the latency is not problem, as it is encountered in software, but it is not recommended to use 

buffer with size larger than 2048 samples, or smaller than 256 samples. Some ASIO control panels 

express the buffer size in samples, while other express the buffer size in time [ms]. In that case we can 

calculate the size in samples using following expression : 

 

buffer_size [samples]  = buffer_size[ms] *samplerate[kHz] / number_of_channels. 

 

Some ASIO drivers allow setup of buffer size (in samples) that is a power of number 2 (256, 512, 

1024,..). In that case, ARTA adjust buffer size automatically. 

 

ARTA always work with two input channels, and two output channels, treating them as stereo left and 

right channels. As ASIO support multichannel devices, user has to choose in a dialog box óAudio 

Device Setupôô which pair of channels will be used in ARTA (1/2, 3/4, ..). 
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1.5 Calibration 
 

The menu command Setup->Calibrate devices opens the dialog box 'Soundcard and Microphone 

Calibration'  shown in Fig. 1.14. 

 

 

 
 

Figure 1.14 Dialog box for the calibration of soundcard and microphone 

 

Three sections lead to the calibration of  

 

(a) soundcard output left channel,  

(b) soundcard input left and right channels and  

(c) microphone calibration. 

 

1.5.1 Calibration of Soundcard Output Left Channel 

It is recommended to follow this procedure: 

 

1. Connect the electronic voltmeter to the left line output channel. 

2. Press the button 'Generate sine (400Hz)' 

3. Enter the voltmeter readout in edit box (in mV rms).  

4. Press the button 'Estimate Max Output mV' 

5. The estimated value will be shown in the box 'Estimated'. 

6. If you are satisfied with the measurement, press the button 'Accept', and the estimated value 

will become the current value of  the 'LineOut Sensitivity'. Also, it will be entered as a value 

for the input channel calibration. 
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1.5.2 Calibration of Soundcard Input Channels 

You can use an external generator or the output channel of the soundcard to calibrate the input 

channels. In case of using the output channel of the soundcard as a calibrated generator: 

 

1. Set the left and the right line input volume to maximum. 

2. Connect the left output to the left line input.  

3. Press the button 'Generate sine (400Hz)' and monitor the input level at bottom peak-meters. If 

the soundcard input is clipping, lower the level of input volume to -3dB.  

4. Enter the value of signal generator voltage in the edit box, but only if it differs from value 

used during output channel calibration (1.5.1).  

5. Press the button 'Estimate Max Input mV '. 

6. If you are satisfied with the measurement press the button 'Accept', and estimated value will 

become the current value of the 'LineIn Sensitivity '. 

7. Repeat 1-6 for the right input channel.  

 

Note: This procedure is recommended as it guarantees that you can connect the soundcard in loopback 

mode. If you want to calibrate input channels with input volume set to maximum, many soundcards 

require a reduction of the level of the output channel.  

1.5.3 Calibration of the Microphone 

To calibrate the microphone you must have a sound calibrator. Then:  

 

1. Connect the microphone preamplifier to the soundcard input (left or right). 

2. Enter the preamplifier gain.  

3. Attach the sound calibrator on the microphone. 

4. Press the button 'Estimate mic sensitivity'. 

5. If you are satisfied with a measurement, press the button 'Accept'. 

 

Note: If you don't know the preamplifier gain, you can set some arbitrary gain value, but that value 

must be used as a preamplifier gain in the 'Audio Devices Setup' dialog box. 

1.5.4 Frequency Response Compensation 

 The quality of measurements depends on the quality of used sensors, i.e. microphones. It is possible 

to enter frequency response of sensor in ARTA and make the compensation of their frequency 

response (by applying the inverse of sensor FR to measured FR).  

The menu command Setup->FR compensation or click on icon   gets the dialog box "Frequency 

Response for Compensation", shown in Fig. 1.15. The dialog has a few controls and a graph that 

shows the frequency response which will be used for FR compensation. 

  

The button Load opens the dialog for loading ASCII files that contain frequency response data. The 

file name must have extension .MIC and data entered in lines of text. Lines that start with a digit or dot 

characters must contain at least two values: first value is frequency in Hz and the second value is 

magnitude of frequency response in dB. The third value is optional. It may be the value of phase or 

any other text that will be treated as comment. All other lines are treated as comment. After 

successfully reading of the compensation file, the path of the file will be shown in the box below the 

graph. 

For example,  file "MB550-B.mic" (shown in Fig. 1.15) has content: 
 
    microphone mb550  

    freq(Hz) Magn(dB)  

    48.280   0.34  

    48.936   0.28  

    49.601   0.21  

    .....   



ARTA User Manual 

 21 

  

 
  

Figure 1.15 Typical frequency response  of an electret microphone.  

 

 

o The check box "Show spline interpolated data" enables us to see the interpolated FR curve 

that will be used in FR compensation. 

o The button 'Copy' copies current graph picture on Windows clipboard. 

o The combo list box 'Range (dB)' sets graph magnitude dynamic range (10-100dB). 

o The button 'Use frequeny response compenstion' enables/disables frequency response 

compensation. 

 

1.6 Getting Pictures of Graphs and Windows  

 
Normally, we work with graph windows and dialog boxes. We also need to get  the copy of the graph 

picture of the graph window picture.  

 

Obtaining copy of the full window picture is simple. User needs to simultaneously press keys Ctrl+P . 

After that command the window picture will be saved in the System Clipboard, from were the user can 

paste it in other opened Windows applications (MS Word, MS Paint and Adobe Paint Shop). 

 

To obtain the copy of the graph picture, that is shown inside the window, user needs to simultaneously 

press keys Ctrl+C  or activate the menu command 'Edit ->Copy', or press appropriate 'Copy' button.   

In main window toolbar, the 'Copy' button is shown as toolbar icon .  

 

This command opens the dialog box 'Copy to Clipboard with Extended Information ', shown in 

Figure 1.16. Here user has to setup three copying options: 

 

1)  In the Edit box user optionally enters the text that will be appended at the bottom of 

the graph.  

2) Check box ' Add filename and date' enables adding text to the graph that shows  file 

name, date and time. 

3) Check box ' Save text' enables saving entered text for the next copy operation.  
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4) Bitmap size is chosen by selecting one of following combo box items: 

Á Current screen size   - variable width and height option  

Á Smallest  (400 pts) - fixed graph width 400 points  

Á Small  (512 pts) - fixed graph width 512 points  

Á Medium  (600 pts) - fixed graph width 600 points  

Á Large  (800 pts) - fixed graph width 800 points  

Á Largest  (1024 pts)  - fixed graph width 1024 points  

 

The options with fixed width give graphs with the aspect ratio 3:2. 

 

The button 'OK'  copies the graph to the system clipboard. 

The button 'Cancel'  cancels the copy operation. 

 

 
 

Figure 1.16 Dialog box 'Copy to Clipboard with Extended Information ' 

 

 

 
 

Figure 1.17 Copy of the graph from Figure 1.15. The extended information shows file name, date, 

time and user defined text. 
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2 Spectrum analyzer 

 

The spectrum analyzer of ARTA is implemented as a real-time FFT based spectrum analyzer. A built 

in generator provides the following signals: sine, two sine, square, triangle, multitone, white noise, 

pink noise, periodic white noise (PN white), periodic pink noise (PN pink) and periodic speech noise 

(PN speech). 

Working with the spectrum analyzer will be explained through the soundcard testing procedure. 

 

2.1 Souncard testing  

 

The easiest way to test the quality of the soundcard is in the Spectrum analyzer mode.  
 

1. Make the loopback connection for the soundcard testing. 

2. Click the menu Mode -> Spectrum Analyzer or click the toolbar icon SPA . 

3. Click the menu Generator->Setup or click the toolbar icon . You will get the dialog box  

    shown in Fig. 2.1. 
 
 

 
 

Figure 2.1 The dialog box for the signal generator setup 

 

 

This dialog box has following controls: 

 

Sine / square generator  section: 
Frequency - enters the frequency of sine signal in Hz. 
Peak Level - chooses the output peak level re full scale peak level  (0dB to -90dB). 

RMS voltage - shows voltage value of line output channel (for calibrated system) 
Dither  Level - chooses: None, 16bit, 18bit or 20bit. 
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Two sine generator section allows the choice of three possible combinations of frequencies and magnitude 

ratios: 
       Def1 -  sets f1=11kHz, f2=12kHz, amplitude ratio 1:1. 
       Def2 -  sets f1=100Hz, f2=8kHz, amplitude ratio 1:4. 
       User - enters two sine frequencies and the amplitude ratio . 

       Note: the two sine signal has the peak level defined in the Sine generator  section ï Peak Level control. 
 
Mult itone and noise generator section: 
       Output volume - chooses the output level re full scale level in range 0dB to -50dB. 
       PN Pink cut off - enters the low frequency cut-off in Hz, for the periodic pink noise. 
       Multitone  - chooses the type of multitone signal (Wideband, Speech range, ITU_T O.81, Low decade,  

       High decade,  Sine+Square). 

 
Note 1:  PN (periodic noise) is a periodic, noise-like signal with a controlled spectrum level and a random phase. 

The periodic noise and multitone belonging to the class of multisine signals (to be explained later).  

Note 2: Jitter test signal is a sine signal with a frequency equal to 1/4 of the sampling rate, and with a LSB bit 

toggled with a frequency equal to 1/192 of the sampling rate.  

Note 3: Multitone test signals contain mix of sine signals with different amplitudes and phases. Their use will be 

explained later. 

 

  
  

Now choose parameters of sine generator:         

Frequency: 1000Hz 

Peak level: -3dB 

Dither level: 16 bit. 
 

4. Using the dialog bar choose: 

  

 
  

Gen: Sine 

Fs (Hz): 48000Hz (sampling frequency or sampling rate) 

FFT: 16384   (number of samples in FFT analysis frame) 

Wnd: Kaiser5   (signal window to suppress leakage in FFT analysis)    

Avg: None   (averaging of the signal)         
 

The same parameters can be set up in a dialog box 'Spectrum Analysis Setup' shown in Fig. 2.2. 

(you get it by clicking the menu Setup->Measurement) . By using this dialog box you set (1) the 

preferred input channel, (2) averaging parameters and (3) the FFT resolution. 

  

 
 

Figure 2.2 The spectrum analysis setup  
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This dialog box has following controls:  
 

Input channel section: 
Combo box chooses left or right channel as active soundcard input channel.  

Averaging section sets: 

Type: None, Linear, Exponential or Peak Hold.   
Max. averages:  the maximum number of averages.  

FFT resolution section sets: 
FFT size:  number of samples in FFT block (4096, 8192, 16384, 32768, 65536 and 131072), 
Window:  Uniform, Hanning, Blackman3, Blackman4, Kaiser5, Kaiser7 or Flat Top window. 
Sampling rate: 8000, 11025, 16000, 22050, 32000, 44100, 48000, 88200 or 96000 Hz. 

 

 

5. Choose: Input channel: Left. 
 

6. Prepare the Windows sound mixer: 

¶ Enable the line-input channel  

¶ Mute the line-input channel in the output mixer.  

¶ Set the line-out volume for maximum output sensitivity. 

¶ Set the line-input volume near minimal input sensitivity. 

 

7. By menu command Setup->Spectrum Scaling ( ), or by clicking right mouse button in graph 

title area, you get the dialog box 'Spectrum scaling' (shown in Fig. 2.3). Use this dialog box to set (1) 

the magnitude scaling, (2) the power weighting and (3) distortion measures. 
 
 

  

 

Figure 2.3 The spectrum scaling  
 

 

Scaling section:   
Magnitude scaling: dBFS (dB re full scale),  

    dBV or SPL (sound pressure level), 

                                  PSD (power spectral density mode in dB V/Hz).  

Voltage units:   dBV or dBu,   
Pressure units:  dB re 20uPa or  

dB re 1Pa (valid only if microphone is connected and enabled). 
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Power section: 
Power Weighting combo box -  chooses: None, A, B or C filter for weighted signal power estimation. 
Show RMS level - check to show the power level at the bottom of the graph. 

 

Distortion section:   
THD  - check to show total harmonic distortions (THD) in sine response testing. 
THD+N  - check to show total harmonic distortions + noise in sine response testing. 

IMD  - check to show  intermodulation distortions (IMD)  in two sine response testing, 

           or transient intermodulation distortion (DIM) in square+sine multitone testing. 
Multitone TD+N - check to show total distortion + noise (TD+N) in multitone response testing. 

 

Normalize with full power ï check to get THD normalized with signal power including higher harmonics. 

Low cut-off (Hz) combo box - sets low frequency cut-off in THD+N measurements. 

2
nd

 and 3
rd

 order IMD ï check to show 2
nd

 and 3
rd
 order IMD defined in SMPTE, DIN, CCIF and IEC 

standards. 

Frequency weighting ï check to use frequency weighting (A,B,C) in THD+N and TD+N measurements. 

 

 
  

8. Check following check boxes: THD, THD+M and Show RMS level . 

 

9. Start recording by clicking the toolbar icon (or via menu Recorder->Run). You should get a 

response like the one shown in Fig. 2.4. This figure can be obtained by the copy/paste operation (menu 

Edit ->Copy).  
 

Slowly increase the volume of the line input channel (using the soundcard mixer) until you get 

the peak level close to -3dB FS. 

 
 

Figure 2.4 Spectrum of 1 kHz sine generator of the soundcard Terratec EWX 24/96 in loopback setup. 

Signal window: Kaiser5, FFT size: 16384,  Fs: 48000Hz. 
 

The bottom of Fig. 2.4 shows the spectrum value at the cursor position (frequency and magnitude), 

RMS level and distortions. The cursor is drawn as a thin line that can be moved by pressing left mouse 

button or by pressing keyboard's left and right keys. 

 

If you get THD+N lower than 0.1% you have a usable soundcard. 

If you get THD+N lower than 0.01% you have a good soundcard. 

 

Note:  During the measurement you can use the control bar to change the averaging type, reset 

averaging, change the sampling frequency, change the type of an excitation signal and an FFT size.  

You can change any plot parameters (dynamic range, frequency range and axis) from dialog box 

'Spectrum graph setup' (you get it by clicking the menu Setup-> Graph setup or by clicking right 
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mouse button in the plot area). The easiest way to adjust graph margins is by using Right Control bar. 

Functions of bar buttons are explained in Figure 2.5. 

  
  

 
 

Figure 2.5 Control bar for graph margins setup (also used for Frequency Response windows) 

  

 

Note: Useful shortcuts to change the top graph magnitude margin are "Up" and "Down" keys and the 

mouse scroll wheel (they move the plot up and down). 

 

2.2 The Spectrum Estimation Procedure 
 

The spectrum shown in Fig. 2.4 is obtained by following procedure: 

 

1. An input signal is sampled with frequency fs and transformed into discrete sequence xn of 

length N=FFT size (the number of samples in the acquisition window is equal to the 'FFT size', 

and can be set to: 4096, 8192, 16384, 32768, 65536 or 131072).  

 

2. The discrete input sequence is multiplied with a window sequence wn (will be explained later) 

 

3. The Discrete Fourier transform  
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is calculated using the FFT algorithm. It gives spectral components as complex values at 

discrete frequencies  

 

fk = k Df ,  

 

where Df  is a DFT spectral resolution  

 

Df = fs / N.  
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For real signals, there are N/2 single sided power spectral components Gk:  
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4. The magnitude spectrum is shown in one of  following scaling modes: 

 
Scaling mode Level Units 

Peak level  

(ref. full scale) 

10 log(2Gk)   dBFS 

RMS level  

(Power spectrum) 
10 log( Gk ³ (input_sensitivity / preamp_gain)

2
 ) dBV  

(or dBu) 

Power spectral density  10 log( Gk ³ (input_sensitivity/ preamp_gain)
2
 / Df) dBV/ÕHz 

(or dBu/ÕHz) 

 

Note 1: If  a signal window wn is applied, then spectrum values are divided by a scale factor 

that is equal to average wn value -  in a RMS level mode, or a rms wn value -  in a power 

spectral density mode. 

Note 2: If the check box Use Microphone is enabled in dialog box 'Audio device setup', 

then RMS or PSD levels are raised by 20log10( 2³10
-5 

Pa) ³ microphone_sensitivity(mV/Pa) ). 

 

5. The spectrum plot shows levels of spectral magnitudes as line-graph.  

 

Note: A DFT spectrum is defined at discrete set of frequencies, so it would be more appropriate to 

show the spectrum as discrete bar-graph, but when we deal with large number of spectral 

components, as is case in ARTA, a line-graph gives better visual insight of spectral magnitudes.  

 

The bottom of Fig. 2.4 shows: 

¶ RMS -  RMS level of an input signal ï defined as 10 log10 (sum of all DFT power spectrum 

components). If the power weighting, in the 'Spectrum Scaling' dialog box, is set to A, B or 

C filter, then each spectral components is weighted, before the spectrum summation, with a 

magnitude response of  A, B or C filters (for definition of these filters see section 2.4). 

¶ THD  - total harmonic distortion ï defined as percentage of the square root of ratio of power 

sum of higher harmonics (H2,H3,..) to the power of fundamental signal harmonic (H1).   
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 An  alternative definition is frequently used:  
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In a denominator a full distorted signal power is used. This definition is closest to the value of 

harmonic distortions that are measured by analog instrumentations in low noise systems. In a 

system with a high noise a better quality measure, is a  THD+N.  

¶ THD+N  ï total harmonic distortion plus noise ï  defined as percentage of the square root of 

ratio of power sum of higher harmonics and the noise power to the total signal power that also 

include distortion and noise power: 
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In analog instrumentation HarmonicPower+NoisePower is obtained by applying notch filter to 

the fundamental frequency. The RMS value of  signal and signal with notched fundamental 

harmonic are measured in some predefined frequency band, usually from some low frequency 

cut-off (10, 20 or  100 Hz)  to  the high-frequency cut-off (22,  30 or 80kHz).  ARTA does not 

use a high frequency limiting. It is automatically done by the antialiasing filter of an input AD 

converter. The low frequency cut-off can be set by the user. 

 

Note: If there is no signal at the card input, then RMS shows the input channel S/N ratio. 

2.2.1 Spectrum Averaging 

The power spectrum averaging gives the estimation of spectral magnitudes of signals that are longer 

than a single acquired sequence. The ARTA offers power averaging with a linear and an exponential 

weighting, and a peak-hold averaging.  

 

Exercise: Set averaging to linear, exponential, or peak-hold, and note the different behaviour.  

 

Note: A power averaging does not lower the noise level. It just gives the average noise level. 

 

Here is a brief explanation of the power averaging weighting.  For M input sequences with spectral 

components Xk
i
 , k=1,2, .. N/2-1, averaged spectral magnitudes Yk

M
 are obtained in the following way: 

 

¶ Linear averaging ï averaged spectral magnitudes Yk
M
, of M input sequences are obtained by 

summing power spectrum with equal weight 1/M. 
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¶ Exponential averaging ï is usually used for monitoring of slow varying spectra. It 

emphasizes recent events, smoothes out high frequency variations and reveals long-term 

trends. The ARTA uses a smoothing filter which simulates a low pass, first order analog filter 

with a time constant T:  
22
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The constant  a  is equal to T fs /( T fs +1).  In ARTA, T is predefined as 10 ³ acquisition time 

of a single sequence.   

 

¶ Peak hold ï actually this is not averaging, just Yk
M
 are equal to maximum values of spectral 

components, 

MiXY i

k

M

k ,..,2,1),max( ==  

 

You can restrict maximum number of averages in the 'Spectrum analysis setup'  dialog box shown in 

Fig. 2.2 (you get it by clicking the menu Setup ->Measurement). 

 

Note: In a classical power spectrum estimation  it is usual to average overlapped time records. This is 

not implemented in the ARTA as ARTA is targeted to measurements of system responses with 

predefined types of signals that are periodic in the analysis window.   
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2.2.2 Signal Windowing 

DFT analysis gives an exact spectrum only if the acquired signal is periodic within the acquisition 

window. If this is not the case, a signal window must be applied to suppress "leakage" errors (i.e. 

when analyzing the spectrum of sine signal these errors give rise to a side-lobe spectrum - see Fig. 

2.5a). Signal windowing is an operation in which the input sequence xn is multiplied with an equal 

length sequence wn that is called a signal window. The ARTA offers following signal windows: 

Uniform, Flat-top, Hanning, Blackman3, Blackman4, Kaiser5 and Kaiser7.  They are defined in Table 

2.1. 

 
Uniform (rectangular) wn = 1,                                                for n = 0,1,2,.., N-1 

Hanning wn = 0.5 (1 ï cos(yn)),                              yn = 2p n / N   

Blackman 3 terms wn = 0.42 ï 0.5cos(yn) + 0.08cos(2yn); 

Blackman 4 terms 

(Blackman ï Harris) 

wn = 0.35875 - 0.48829cos(yn) 

        + 0.14128cos(2yn) - 0.01168cos(3yn); 

Flat-top wn = ( 1 - 1.93cos(yn) + 1.29 cos(2yn)  

       - 0.388 cos(3yn) + 0.0322 cos(4yn) ) / 4.6402  

 

 

Kaiser5  (b = 5p) 

 

Kaiser7  (b = 7p) 
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Table 2.1 Definition of signal windows used in ARTA 

 

When applying the signal window, it is recommended to follow these rules: 

¶ for continuous nonperiodic signals (noise) use the Hanning window 

¶ for measuring harmonic and intermodulation distortions use the Kaiser5 or the Blackman4 

window, but to get 24-bit resolution use  Kaiser7 window 

¶ for calibration with a sine signal use the Flat-top window 

¶ for periodic noise, multitones and other signals that are periodic within the acquisition window 

use the Uniform window 

 

Exercise: Change the signal window and repeat measurements. Typical results are shown in Fig. 2.6 

 

       
a) Uniform                         b) Hanning                         c) Flat-top 

       
d) Blackman3                     e) Blackman4                     f) Kaiser5 

 

 

 

 

 

 

 

Figure 2.6 Spectrum of 1kHz 

sine signal with applied 

windows:  

 

a) Uniform,  

b) Hanning,  

c) Flat-top,  

d) Blackman3,  

e) Blackman4,  

f) Kaiser5   

 
(Magnitudes shown 20dB/div). 
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2.2.3 Spectrum Graph Setup 

The menu command Setup->Graph Setup (or click of right mouse button in the plot area), opens a 

dialog box 'Spectrum Graph Setup' (Fig. 2.7). Use this dialog box to adjust (1) the dynamic range 

shown, (2) the frequency range shown and (3) the frequency axis resolution. 

 

 

 
  

Figure 2.7 Dialog box for spectrum graph setup 

 

Magnitude axis section: 

Top (dB) ï enters the level in dB for top graph margin. 

 Range (dB) ï enters the graph magnitude range. 

 

Freq. range (Hz) section: 

High ï enters the highest frequency shown (in Hz). 

Low ï enters the lowest frequency shown (in Hz). 

View All  ï sets Low and High frequencies to enable the view of all DFT spectrum components.  

 

Frequency axis section: 

Type - Four types of the frequency axis resolution are available: 

Linear  ï DFT spectrum shown on a linear frequency axis, 

Logarithmi c - DFT spectrum shown on a logarithmic frequency axis, 

Octave smoothing - power levels in smoothed (sweeped) octave bands are shown,  

Octave bands ï power levels in discrete octave bands are shown (simulate the RTA). 

 

Smoothing ï The Octave smoothing and Octave bands modes are useful for monitoring the spectrum of 

wideband signals. The frequency resolution of these modes can be set to 1/n-octave, where n can be: 

1,2,3,6,9,12 and 24. 

 

Filtered smoothing - Smoothing 1/n-octave filters have, by default, brick wall characteristics, but if you 

check the box 'Filtered smoothing' then smoothing filters have characteristics of class I IEC filters (six pole 

bandpass Butterworth filters). 

 

2.2.4 Graph Colors and Grid Style Setup 

Graph colors can be changed in two categories: background and foreground. 
 

o User sets the background color to "Black" or "White" by clicking the menu command 'Edit -

>B/W background color'  or by clicking the toolbar icon .   

o User sets an arbitrary foreground color  for every graph element by clicking the menu 

command 'Edit ->Colors and grid style'. That opens the  'Color Setup' dialog box shown in 

Fig. 2.8. Clicking the left mouse button on a named color rectangle opens the standard 

Windows dialog box 'Color' shown in Fig.2.9. 

Note 1: If the check box 'All overlays with same color' is checked, all overlays will be 

plotted with same color. 
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Figure 2.8 Dialog boxes for graph color setup a) for black background and b) for white background 

color 
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Figure 2.9 Standard Windows color picker 
  
  

Colors are used for plotting curves in a following way: 
 

Plot pen 1 is used for plotting gated impulse response,  spectrum and FR magnitude,  

Plot pen 2 is used for plotting phase, 

Plot pen 3 is used for plotting ungated impulse response and coherence function. 

 

 

Graph grid style is defined with three options: 

 

¶ If the check box  'Dotted graph grid'  is checked, the graph grid in all types of graphs will be 

drawn in dotted style. 

¶ If the check box  'Add axes tick marks' is checked, FR and spectrum graphs axes will have 

tick marks. 

¶ If the check box  'Add subgrid on manitude axis' is checked, FR and spectrum graphs will 

have a denser magnitude grid. This option disables the dotted grid option. 

 

 

The button 'Default' restores default colors and grid style. 

 

 

2.3 Frequency Resolution of DFT and Octave-Band Analyzers 
 

The frequency resolution is defined as a minimal difference in frequency necessary to distinguish two 

spectral components. It depends on (1) sampling frequency (fs), (2)  'FFT size' and (3) applied signal 

window.  

DTF analysis of N input samples gives N/2 spectral components whose power spectrum equals the 

signal power that can be obtained with an ideal bandpass filter that has constant bandwidth  

Df = fs / N, at frequencies fk = kDf,  k=0,1,2,..N/2-1. The bandwidth also depends on the applied signal 

window. The table 2.2 shows the effective noise bandwidth and the side lobe suppression of signal 

windows that are used in the ARTA.  
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window  effective bandwidth side lobe suppression 

UNIFORM  1.0 13 dB 

HANNING 1.5 31.5 dB 

BLACKMAN3  1.7268 66 dB 

BLACKMAN4  2.0044 94 dB 

KAISER5 2.2183 130 dB 

KAISER7 2.6849 160 dB 

FLATTOP  3.7703 73.6 dB 

 

Table 2.2 Characteristics of ARTA signal windows 

 

In octave band analyzers the power spectrum is measured at some frequency fk in a frequency band 

that has a constant relative bandwidth. In a 1/n-octave filter, the relative bandwidth is equal to 
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For example, the 1/3-octave filter has bandwidth 23% of the central frequency.   

 

Central frequencies of 1/n octave bands are determined by the expression: 

 k
n

kk
n

k ffff
1

11

1

2,2
-

-- ==  

 

with 1kHz used as reference value. This formula gives values that are close to ISO standard 

frequencies given in table 2.3.  

 
16.0   20.0   25.0  

31.5    40.0   50.0 

63.0    80.0    100 

125     160     200 

250      315    400 

500     630    800 

1000   1250  1600 

2000   2500  3150 

4000  5000  6300 

8000 10000  12500 

16000 20000  25000 

 

Table 2.3 ISO 266 - Preferable central frequencies of 1/1-and 1/3-octave bands. (The first column 

shows 1/1-octave band frequencies)  

 

In the Spectral analysis window an estimation of the octave band power is determined by summing 

spectral powers of DFT bins that are inside 1/n-octave frequency band. Two methods of summing are 

implemented, as illustrated in Fig. 2.10., and defined as follows:  
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Figure 2.10 Summing spectral powers in a band-pass of  

a) brick wall filter, b) 6-pole Butterworth bandpass filter 

 

 

Power Pk, in the band f1k  ¢ fk ¢  f2k, can be estimated in two ways: 

 

1. Power output of brick wall band-pass filter - First, it is assumed that each DFT component 

gives the constant power spectral density Gn/ Df  in the frequency region     nDf-Df/2 ¢  f  ¢ 

nDf +Df /2 (this way we get piecewise continuous spectral density). Then, the power in a band 

is obtained as an integral of continuous spectral density function from  f1k  to f2k. This process 

is illustrated in Figure 2.10a).  The lowest frequency is determined by frequency of DFT bin 

that has relative bandwidth equal to 1/n-octave. 

 

2. Power output of 6-pole Butterworth bandpass filter ï First, the power spectrum is weighted 

with a squared magnitude of a bandpass filter response. Then, Pk is estimated as a sum of 

power spectral components between frequencies where the filter response is -20dB. This 

process is illustrated in Figure 2.10b).  Additionally, it is required that at least three DFT 

spectral components contribute to that band. This requirement means that the bandwidth of a 

1/n-octave band must be greater than double the DFT resolution bandwidth, which gives that 

the lowest frequency of a 1/n-octave band is:    
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For example, for a sampling frequency fs = 48000Hz and the number of samples N=16384, the 

lowest frequency of DFT spectra is equal to 2.93Hz, the lowest 1/3-octave band is 25Hz and 

the lowest 1/12-octave band is 100Hz.  

 

 

The first method is preferred method fot the high resolution analysis, but if the user wants to get the 

response as close as possible to responses of 1/n-octave analog filters, or close to the response of 

psycho-acoustical critical band filters, the second method gives better results. 

 

The power spectral density of the k-th band is equal to Pk /( f2k - f1k). 
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2.4 RMS Level 
 

The RMS signal level is shown at the graph left bottom position, but only if the dialog box 'Spectrum 

Scaling' (Fig 2.3) has checked the button ' Show RMS Level '. The unit for the RMS level is dBFS or 

dBV or dBu, but if the microphone is used, then unit is dB re 20uPa or dB re 1Pa.  

 

The same dialog box has a section 'Power - Weighting', where user chooses to apply, to input signal, 

one of IEC 60651 standard weighting filters (type A, B or C). Appropriately, the level labeling is 

appended with the text (A), (B) or (C).  The frequency response of these weighting filters is shown in 

Fig 2.11.  

 

 

 

 
Figure 2.11 A, B and C frequency weighting (IEC 60651) 

 

 

The RMS value is defined as:     ñ
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The ARTA uses the integration constant T equal to the duration of one FFT block (examples are 

shown in table 2.4).  

 

 
FFT- length  4096 8192 16384 32768 65636 131072 

T (fs = 48000Hz) seconds 0.085 0.170 0.341 0.682 1.365 2.730 

T (fs = 44100Hz) seconds 0.093 0.185 0.371 0.743 1.486 2.972 

 

Table 2.4 FFT-block duration (for sampling frequencies 48000Hz and 44100Hz). 
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2.5 The Time Record  
 

The time record of the last captured signal can be seen in the Time Record window (shown on Fig. 

2.12). It can be activated by clicking the menu Recorder->Time record, or by clicking the toolbar 

icon .  

 

 

 
 

Figure 2.12 Time record of the last captured signal  

 

 

The plot shows a properly scaled time record of the input signal. The yellow line denotes the cursor 

position, and the red line denotes the marker  position.  

 

User sets the cursor position by pressing and dragging the left mouse key, and marker position by 

pressing and dragging the right mouse key. Double clicking the right mouse button turns the marker 

on and off.  

 

The 'Cursor:'  label denotes the report for the magnitude of the signal at the cursor position (time in 

ms or sample position - in braces).  The 'Gate:' label denotes the report for the difference in time (and 

in samples) between the cursor and the marker.  
 

Buttons on the right pane serve as commands to Scroll the signal plot, to Zoom plot in and out, to 

change the Gain and vertical Offset.  

 

Zoom ratio  is shown above the upper right corner of the graph. It is written as ratio p:n, where p 

means number of pixels used to draw n signal samples. Maximal zoom is defined with ratio 8:1, 

normal zoom is defined with ratio 1:1 and minimal zoom is defined with ratio 1:m, where m=signal 

length/graph width in pixels. 
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Zoom commands: 

Up - increases the zoom ratio. 

Down - decreases the zoom ratio. 

Min  - sets minimal zoom ratio (to show almost all signal samples). 

Max  - sets maximal zoom ratio, by following these rules: 

¶ If  marker is set, then all samples between the cursor and the marker will be shown with 

maximum possible zoom ratio.  

¶ If the marker is turned off,  the plot is zoomed to ratio 1:1 with cursor position sets to first 

graph point (or to ratio 8:1 if previous zoom ratio is lower or equal to 1:1). 

 
Gain commands: 

Up - increases the gain factor. 

Down - decreases the gain factor. 

Min - sets minimal gain factor. 

Max  - sets maximal gain factor. 

 

Offset commands: 

Up - increases the vertical offset. 

Down - decreases the vertical offset. 

Null - sets the vertical offset to zero.  

 

Scroll commands: 

Left  ï scrolls the plot to the left. 

Right ï scrolls the plot to the right. 

 

 

The 'Channel' combo box shows the currently used channel (left or right).  

 

You can also use following shortcut keys: 
Up and Down   to change the gain, 

Ctrl+Up  and Ctrl+Down   to change the vertical offset, 

Left  and Ctrl+Left   to scroll the plot left, 

Right and Ctrl+Right   to scroll the plot right,  

Shift+Left and Shift+Right  to move the cursor left and right,  

PgUp and PgDown  to change the zoom factor.  

Del    to set cursor position to 0, 

Ctrl+Del    to remove marker, 

Ctrl+Ins    to set marker on cursor position, 

 

Shortcut keys are active if graph window has a focus. The focus is set by clicking the mouse in 

the graph area. 

 

Dragging the mouse in the label area scrolls the plot horizontally and vertically.  

Double-clicking of the left mouse button in the time axis area toggles the time/sample position 

labeling. 

 

Menu commands are: 

 
File 

 Export ASCII   - saves time and amplitude data in textual file. 

Info   - opens message box that shows the signal RMS value and crest factor.  

If the marker is set, the RMS value is determined for the gated part of the signal. 

 

Edit  

 Copy ï copies graph window to clipboard. 

 BW background color ï changes background color to back or white. 
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2.6 Monitoring Spectra of Wideband Signals 
 

Being in the Loopback measurement setup, we shall explore following random excitation signals: 

 

¶ continuous white noise    - use Hamming window and averaging 

¶ continuous pink noise    - use Hamming window and averaging 

¶ periodic white noise (PN white )  - use Uniform window and no averaging 

¶ periodic pink noise (PN pink)   - use Uniform window and no averaging 

¶ periodic speech noise (this signal is exclusively used in the estimation of speech transmission 

index ï STI) 

 

Note: Classical real-time audio analyzers use the pink spectrum excitation for an octave-band or an 

octave-smoothed analysis of the loudspeaker response. In an ideal case (after the averaging) a pink 

spectrum excitation gives a flat response in the Power Spectrum mode (dBFS or dBV RMS).  If we use 

the white spectrum excitation, then an octave band or an octave-smoothing analysis gives the flat 

response in the PSD mode (power spectral density mode). 

 

It is important to study characteristics of white and pink spectrum signals, as they will be used for 

frequency response and impulse response estimation.  

 

Exercise: 

 

First, set: 

Generator:  White noise 

Scaling:   PSD 

FFT size:   32768 

Fs (Hz):  48000Hz 

Window:   Hanning 

Fr. axis:   Octave smoothing, 1/3 oct.,  20Hz-20000Hz 

Averaging:  None 

 

You will get the spectrum shown in Fig. 2.13. 

 
 

Figure 2.13 Octave-smoothed spectral density of the white noise generator (PSD scaling) 

 

Note that spectral density of a short "white" sequence is not flat. The ripple is very high (°10 dB).  

If we repeat measurements in the averaging mode set to Linear, after 20 averages we will get the 

spectrum shown in Fig. 2.14. The ripple is lowered to  °1dB. By using 100 averages, the ripple can be 

lowered to °0.2dB. 
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Figure 2.14 Octave-smoothed spectral density of the white noise after 20 averages (PSD scaling). 

 

 

Now if we change to: 

 

 Generator:  PN white (periodic white noise) 

 Window Uniform  

 

we get the spectrum shown in Fig. 2.15. 

 
 

Figure 2.15 Octave smoothed spectral density of the periodic white noise  

 

What is obvious is that periodic noise signal has a perfectly flat spectral density without averaging and 

without any signal windowing.  

 

Note: The same result can be obtained with a pink noise excitation (PN pink) and a scaling set to 

dBFS or dBV.  
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2.7 The Periodic Noise  
A periodic noise is a signal that belongs to the class of random phase multisine signals (RPMS). It is a 

zero dc, periodic signal that contains M sine components, each with a random phase:  
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In the ARTA, a wideband multisine signal is generated using the inverse DFT: 
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Three types of the periodic noise are implemented in the ARTA: 

1. White PN - it has Ak = const, and white spectrum. 

2. Pink PN - it has Ak =Õ2A2k, and spectral magnitudes roll-off 3dB/oct (after some cut-off 

frequency - see Fig. 2.16). In the ARTA, a variable low frequency cut-off frequency can be 

changed in the dialog box 'Signal Generator Setup'. The pink noise is usually used in octave 

band or 1/n octave smoothing modes with a dBV scaling (see Fig. 2.15), as it gives a linear 

frequency response in bands with a constant relative bandwidth. 

3. Speech PN - it has spectral magnitudes determined by IEC 60268-16 standard for Speech 

Transmission Index measurement (see Fig. 2.18). 

Amplitudes of these signals have a normal distribution, and a crest factor is 12-13 dB. By further 

processing, the crest factor can be lowered to values below 6dB. In the ARTA, the periodic noise 

generation is implemented with a crest factor lower than 10dB. 

 

Figure 2.16 Octave-smoothed spectral density of periodic pink noise (PSD Scaling) 
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Figure 2.17 Octave-band spectrum of periodic pink noise (dBV Scaling) 

 

 

 
 

Figure 2.18  1/3-octave band spectrum of periodic "speech" noise 
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2.8 Testing with Two Sine Signal 
The excitation with two sine signal is normally used to measure intermodulation distortions. In the 

dialog box 'Signal generator setup' the user can choose two predefined measurement setups (11kHz 

&12kHz with a magnitude ratio 1:1, and 100Hz & 8kHz with a magnitude ratio 4:1) or sets the User 

defined choice (two sine frequencies and a magnitude ratio). 

 

To measure intermodulation distortions, follow this procedure: 

1. Generator type:  two sinus 

2. In the 'Spectrum Scaling' dialog box check the IMD box. 

       Figure 2.19  

 

3. In the dialog box 'Signal Generator Setup',  set two sine frequencies in User section to 11000Hz 

and 12000 Hz, and an amplitude ratio to 1:1, as shown in Fig. 2.20. 

   Figure 2.20  

4. Set: 

Frequency axis scaling:  Log 

Averaging:    Linear 

Window:    Kaiser5 

 

Figure 2.21 Intermodulation distortions of the soundcard Terratec EWX 24/96 (measured with two 

sinusoids: 11kHz and 12kHz)  

 



ARTA User Manual 

 44 

The example from Fig. 2.21, shows the intermodulation spectrum for the 11 kHz and 12 kHz 

excitation.  Note the dominant intermodulation component at 1 kHz (it is the difference between 11 

kHz and 12 kHz). 

2.8.1 Intermodulation distortion definitions 

The nonlinear intermodulation distortion is characterized by the appearance, in the output of a device, 

of frequencies that are linear combinations of the fundamental frequencies and all harmonics present 

in the input signals.  Harmonic components themselves are not usually considered to characterize 

intermodulation distortion.  

To explain how ARTA estimate intermodulation distortion we use notation I(nf1°mf2) to express the 

magnitude of a intermodulation spectrum component at frequency nf1°mf2. The spectrum of the 

excitation signal has two components with magnitudes I(f1) and I(f2). It is common to say that nf1° mf2 

is a distortion component of an order n+m. 

There are several methods to express the percentage of intermodulation distortions:  

¶ Power method 

¶ SMPTE (Society of Motion Picture and Television Engineers) and DIN 45043 standard method 

¶ IEC-60286 standard method 

¶ CCIF (now ITU_R) standard method  

 

Here we briefly discuss these methods. 

Power Method 

Intermodulation distortion is calculated as the square root of the ratio of power sum of intermodulation 

products components to the total signal power.  
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In ARTA,  only largest components are used,  for  1 < m,n < 8. 

IEC 60268 method 

For loudspeaker measurements, the standard IEC 60268 ï 5 defines two factors: 
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These factors show dominant intermodulation distortions when  f2 >> f1., i.e. for loudspeaker testing 

we  use f2 = 8.5 f1. 

For amplifier distortion measurements, when f2  º f1.,  the standard IEC 60268 ï 3 defines two factors: 
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2nd order Difference frequency distortion factor  
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3rd order Difference frequency distortion factor  
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DIN 45043 (SMPTE) method 

This method assume that  f2 >> f1, usually f1= 250Hz, f2 = 8000Hz in  DIN, or f1= 60Hz,  f2 = 7000Hz 

in SMPTE standard . Amplitude ratio is I(f1): I(f2) = 4:1. 

The SMPTE measurement method is determined for analog instrumentation. First, the output distorted 

signal is high-pass filtered at 2000Hz to remove influence of component I(f1). Then, the filtered signal 

is amplitude demodulated at frequency f2, and low pass filtered at 700 Hz to get the power of 

modulation components at f2° nf1. Only a few components are used. Finally, IM distortion is expressed 

as square root of ratio of modulation power to power of I(f2). 

ARTA follows definition from DIN standard called total intermodulation factor: 
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In this expression, amplitudes of the sidebands are rms summed and expressed as a percentage of the 

upper frequency level. This intermodulation factor is very close to the value of intermodulation 

distortion that can be measured by SMPTE analog instrumentation. 

 

CCIF (ITU -R) method 

CCIF standard for intermodulation distortion measurements recommends excitation with two closely 

spaced frequency components f2  º f1..  It is recommended to use f1= 13kHz,  f2 = 14kHz in 15kHz 

limited system, or f1= 19kHz,  f2 = 20kHz for amplifier testing. Recommended amplitude ratio is I(f1): 

I(f2) = 1:1. 

Dominant intermodulation products are at difference frequencies. Second order DFD is at frequency f2  

- f1.,  the third order DFDs are at frequencies  2f2  - f1 , 2f1 -  f2 , then follows DFDs at frequencies  3f2 - 

2f1, 3f1 - 2f2, é and so on. 

Many analog instruments that conform to CCIF standard measure only 2
nd

 order difference frequency 

distortion DFD2, i.e. 

2DFDIMDCCIF =  (in analog instrumentation) 

Some CCIF instruments also measure 3rd order difference frequency distortion DFD3.   

Due to the close frequency separation, this technique is also applied in some swept-frequency 

analyzers. 

Modern FFT analyzers are capable of measuring all distortion products. ARTA reports DFD2 and 

DFD3 and also a total intermodulation distortion (IMD),  calculated by power method using twenty 

strongest intermodulation spectrum components. 
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Calculation and report of intermodulation distortion s in ARTA  

ARTA uses all described method to calculate the intermodulation distortion. The choice of used 

method is determined automatically from the ratio of frequencies  f2  and  f1, in the following way: 

¶ If  f2 / f1 < 2   ARTA uses CCIF method and reports difference frequency distortion DFD2 and 

DFD3 plus IMD (defined with power method). 

¶ If  f2 / f1  > 7   ARTA uses DIN (SMPTE) method and reports modulation distortion:  IMDDIN,  

MD2 and MD3. 

¶ If  2 < f2 / f1  < 7  ARTA uses Power method and reports IMD 

If the ratio of amplitudes differs from recommendations in standards, it should be reported by the user 

additionally. 

 

2.9 The Multitone Testing 
 

The multitone testing is becoming a very important for testing the quality of digitally coded audio 

signals. The multitone belongs to the class of multisine signals. It is a sum of several sine signals with 

constant amplitude and phases that are optimized to give the lowest crest factor.  

 

Following multitone signals are implemented in the ARTA: 

 

¶ Wideband range  1/3 octave spaced sine signals from 20Df  to fs/2. Crest factor  12 ° 

1dB 

¶ Speech range  Linearly spaced sine signals from 100Hz to 500Hz, plus 1/3 octave 

spaced sine signals from 500Hz to 8kHz. Phases optimized for crest 

factor 10 ° 1dB. 

¶ ITU_T  O.81     39 sine signals with frequencies spaced 100Hz (from 100 Hz to 

3800Hz). Phases are determined according to ITU_T 

Recommendation O.81. Crest factor  10 ° 1dB 

¶ Low decade range  Ten sine signals, 1/3 octave spaced in a low decade of the sampling 

range. Crest factor  10 ° 2dB 

¶ High decade range  Ten sine signals, 1/3 octave spaced in a high decade of the sampling 

range. Crest factor  10 ° 2dB 

¶ Square + sine Sum of periodic square pulses of frequency  f1=3.18kHz and sine of 

frequency f2 =15kHz, with amplitude ratio V1: V2= 4:1, is normally 

used for testing transient intermodulation distortion (DIM). For 

testing amplifier it is recommended to use sampling frequency 192 

kHz or 96kHz. DIM in percentage is defined  with expression [57]: 
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where Vnt is amplitude of intermodulation component f2 - nf1, where n 

is a positive integer and V2 is the amplitude of the sinusoid. 

All multitone components are generated so that each sine frequency coincides with a frequency of 

DFT bins. That is why; in analyzing the response to the multitone, we do not need to apply the signal 

windowing.  Fig. 2.22 shows the spectrum of the ñspeechò multitone passed through a GSM system. 

Note a high percentage of distortions. 
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Note: The term TD+N (total distortion + noise) is a quite new. It is not accepted in any standard yet. 

Its meaning is: TD+N is the percentage of the square root of the ratio of power of all noise bins to 

the power of multitone. Intermodulation distortion in Square+sine mode is expressed as 

DIM (%). 

 

 
 

Figure 2.22 The spectrum of the ñspeechò multitone passed through two mobile phones in a GSM 

system.  

 

 

Note: Distortion testing with multitone signal seems to be the only meaningful measure for distortions 

in coded systems. 

 

2.10 Monitoring Measurement Dynamics 
 

During measurements the user can check the measurement dynamic range in peak-meter boxes of the 

Status Bar shown in Fig. 2.23 
 

 

 
 

Figure 2.23 Status bar of ARTA windows 
 

The left text shows the current menu context.  

The right text box shows the measurement mode.   

Text boxes L: and R: show maximum full-scale levels of left and right input channels during the 

measurement. These "peak-meters" have a dynamic range from -100 to 0 dB.  

If  input channels are overloaded then these peak-meters show the text "OVRL". 

 

2.11 Spectrum Overlay  
 

The overlay is a curve that is permanently shown besides the currently shown measured curve. 

During or after measurements user can set the current curve as an overlay by clicking the menu 

command Overlay->Set or by pressing keyboard keys Ctrl+A . Besides spectrum magnitude and 

overlay curves, the graph can show the difference between spectrum magnitude and overlay. To 

enable this, menu item Overlay->Show difference from overlay must be checked. 
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As an example, the Figure 2.24 shows three curves: black curve shows spectrum magnitude after 100 

averages, green curve shows overlay obtained from spectrum after 2 averages and blue curve shows 

difference of spectrum magnitude and overlay curve. 
  
  

 

  

Figure 2.24 Black curve shows spectrum magnitude after 100 averages, green curve shows overlay 

obtained from spectrum after 2 averages and blue curve shows difference between spectrum 

magnitude and overlay curve.  
 
 

The overlay can be removed by menu command Overlay ->Delete. 

 

Overlay can be saved to a disk (menu command Overlay->Save) or loaded from a disk (menu 

command Overlay->Load).  

 

Overlays are saved in binary format files with the extension ñ.OVSò. 
 

Almost in the same manner overlays are used in the Frequency response window, but they are saved in 

files with extension .OVF. 

 

Note: Values of current spectrum curve can be saved in textual fi les (menu command File->Export 

ASCII  or File->Export  CSV).  The saved file contains lines of text with values of frequency in Hz 

and magnitude in dB. 

 

Note: Overlay level  depends on type of spectrum scalling. If it is made in a PSD mode it is valid in 

that mode. The same holds for power spectrum mode (dBV, dBFS). 
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2.12 Saving generator signals in a .wav file 

 

Sometimes it is necessary to use external signal generator, for example, for testing acoustics in a car or 

for testing a CD player. All signals that can be generated by ARTA (noise, sine, and jitter, multitone) 

can be saved as a Microsoft .wav file. The menu command 'Generator->Save in .wav file' in mode 

FR2, FR1 and SPA opens the dialog box 'Save generator signal' as shown in Fig. 2.25. 

 

 

 
 

Figure 2.25 Dialog box for making multi-channel .wav files with ARTA generated signals.  

 

Three sections serve to set the type of signal, the wav file format and signal level and duration. After a 

proper setup, a button 'Save in *.wav file' opens a dialog box for saving a file. If a more advanced 

generator setup is needed it can be activated by pressing button 'Temporary generator setup'. It will 

open the 'Signal generator setup' dialog box (as shown in Fig. 2.1). 

 

Wav Format section has following controls: 
Sample rate (Hz) - sets the sampling frequency.  

Bits per samples - sets the number of bits in PCM coded sample (16, 24 or 32).  

Mono/Stereo/5.1 - sets number of channels to mono, stereo or 5.1 multi-channel. 

Check Boxes FL, FR,, C, LF, BL, BC set which channel in multi-channel stream will contain generated 

signal (FL ï front left, FR ï front right, C- centre, BL- back left, BR ï back right and LF ï low frequency).  

 

Signal type section has following controls: 
Type -  sets type of signal that will be generated (sine, two sine, jitter test, multitone, continuous white 

noise, continuous pink noise, periodic noise: PN white, PN pink, PN speech).   

Text box shows the frequency of sine or two sine signals as shown in edit box. To change this (press button 

'Temporary generator setup'). 
 

Level and Duration section has following controls: 
Level (dBFS) - edits the signal amplitude relative to the PCM full scale value. 

Duration (min) - edits the duration of signal in minutes. 
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3 Theory of the Frequency Response 
Measurements  

 

3.1 LTI Input/Output relationship  
The frequency response measurement is based on the classical Fourier analysis which states that every 

time signal, with a finite energy, has a corresponding Fourier transform. In a system analysis we 

assume that linear time-invariant (LTI) system is excited with a signal x(t) and on output has signal 

y(t). Both signals x(t) and y(t) have corresponding Fourier transforms X(f) and Y(f). 

 
Figure 3.1 The LTI system  

 

The relationship between the input and the output of a LTI system, in the frequency domain, can be 

expressed as: 

 

)()()( fHfXfY =  

 

where complex function H(f) is called a frequency response: 
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|H(f)| is termed a magnitude response, and j(f) is termed a phase response. The frequency response 

shows how the system changes the magnitude and phase spectrum of an input signal. 

 

The inverse Fourier transform of the frequency response is called impulse response. We denote it as 

h(t).   

 

The product X(f) H(f) has a Fourier pair in the time domain defined by the convolution x(t)Ãh(t). This 

convolution is equal to the output signal y(t):  
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The function h(t) is called impulse response of the system, as it is a system response to an impulse d-

function excitation. It is obvious, as by analyzing the convolution d(t)Ãh(t), we get: 
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The system frequency response is usually estimated by using the input-output cross-spectrum and the 

input auto-spectrum. By rewriting the expression for the transfer function in the following form:  
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we can get the frequency response by dividing the input-output cross-spectrum with the input auto-

spectrum (star denotes the complex conjugate value). This equation is usually called H1 estimator.  

 

Fourier transform pairs of the cross-spectrum Sxy(f) and the input auto-spectrum Sxx(f) are the cross-

correlation Rxy(t) and the auto-correlation (Rxx(t)), i.e. 

 

)()( fStR xyxy Ú       "cross-correlation" 

)()( fStR xxxx Ú       "auto-correlation" 

 

If the system input has a white spectrum ( Sxx(f)=1), then Rxx(t)=d(t), the impulse response is equal to 

the input-output cross-correlation; 

 

 )()( tRth xyº ,   if input has white spectrum 

 

Using the H1 estimator for the frequency (and impulse) response estimation is important, as it will be 

shown that this estimator has good properties in reducing the influence of the noise and distortions. 

The preceding theory is valid only for noiseless environment and for the excitation signal that has 

infinite duration. In practice we always have some noise present and we can only analyze signals of 

finite duration.  

 

Fig. 3.2 shows the measuring system that is typical in acoustical measurements. The computer 

generated signal g, after D/A filtering with transfer function D, is applied to the test system that has 

the transfer function H. Note that H represent the best linear fit of the possible nonlinear transfer 

function. The generator noise is neglected. The output from the test device, together with the additive 

system noise n, is acquired by the computer as a discrete signal sequence y. The acquisition process 

implies the use of an antialiasing filter that has the transfer function A.  

 

 
Figure 3.2 Block diagram of the measuring system  

 

Note: In acoustical measurements we neglect the influence of the generator noise and the noise in the 

input channel x, as they are much smaller than the noise and distortions in the output channel y. 

 

In a dual channel system the input to the test device is acquired by the computer as a discrete sequence 

x. In a single channel system we do not measure the signal at the system input, and we consider the 

known signal g as a system excitation.   

 

In next sections we shall discuss dual channel and single channel measurement systems. 
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3.2 Dual Channel System with Continuous Noise Excitation 
In a classical Fourier analyzer the excitation is a random noise and the frequency response is estimated 

by dividing the averaged cross-spectrum X
*
Y with the averaged auto-spectrum X

*
X of N input and 

output discrete sequences xi and yes. We define the H1 estimator as:  
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where He(f) denotes the estimated frequency response. Brackets <> denote the averaged value The H1 

estimator gives biased estimate of the real transfer function H(f), which is dependent on the noise, 

distortions and the delay between input and output channel.  

When only the noise contributes to the bias, the effect of averaging can be expressed by the equation: 
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Note that signal term is summed coherently, while the stochastic part of the noise is power summed.  

 

The conclusion is that the averaging lowers the noise level proportionally with a square root of number 

of averages, thus improving the measurement S/N by 10log(n). If nonlinear distortions are present, 

then part of the system noise is coherent with a generated signal, and a better measure for the 

proportionality of the noise+distortion and a number of averages is 1 /g Õn, where g  is the input-output 

coherence function, defined as; 
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The coherence function is a measure of the proportion of the power in y that is due to linear operations 

on the signal x. When estimating the transfer function, the coherence function is a useful check on the 

quality of data used. The maximum value of coherence is 1. In the ARTA you can display the 

coherence, so it is possible to check the coherence associated with "double channel" measurements. 

Practically, we must have g
2
 close to 1 to ensure the good estimation, but we must keep in mind that 

coherence has a sense only if the number of averages is greater than 1. 

 

 
 

Figure 3.3 Illustration of the uncorrelated estimation in a classical Fourier analyzer 
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Main problems in classical Fourier analyzer with the continuous noise excitation are: 

 

¶ The excitation signal does not have the constant spectrum. This gives the frequency selective 

noise bias. It is high at frequencies where the generator spectrum has notches. This resolution 

bias can be greatly reduced by increasing the number of averaging cycles.  It is recommended 

to make at least 8 spectrum averages and monitor the coherence function.  

 

¶ In a system with a large delay between the input and the output (see Fig. 3.2), i.e. when 

measuring loudspeaker in room response, or response of communication systems with high 

delay, there will be low correlation between measured  input and  output signals. In the ARTA 

it is possible to delay the acquisition of the input channel, so this kind of error can be 

eliminated. But, if we measure the frequency response in the highly reverberant environment, 

it is not possible to compensate for all possible delays.  

 

Both problems can be eliminated by using the periodic noise excitation. 

 

3.3 Dual Channel System with Periodic Noise Excitation 

If  the excitation is done with N different periodic noise sequences, the frequency response estimator 

can also be of the form: 
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This type of averaging is called the frequency domain asynchronous averaging. Theoretically it has 

the same power in reduction of the noise and distortions as the H1 estimator, but the use of the H1 

estimator is preferred as it enables us to monitor the coherence function. In the ARTA we refer to both 

methods as the frequency domain averaging. 

 

 
 

Figure 3.4 Illustration of the signal generation and acquisition in the frequency domain asynchronous 

averaging process 

 

For the correct implementation, two conditions must be met: 

 

¶ Start of the acquisition must be after the preaveraging cycle that is necessary to reach the 

steady state response. 

¶ After every acquired block, the signal generation must be stopped, and the new PN sequence 

generated.  

¶ The length of an FFT block must be equal to the length of the generated periodic noise 

sequence.  This guaranties that generated and acquired signals are always correlated, so there 

will be no bias due to the input/output delay. 
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This method of the excitation - with the interrupted periodic noise - is the best choice for 

measurements of the frequency response in communication systems that are voice activated and have a 

time-variant signal processing (automatic gain control and noise reduction). The interrupted noise 

keeps the communication channel in an "active" state, while measurements are taken in a small 

interval of time to assure the system stacionarity. 

If the excitation is done with a single periodic sequence, repeated N times (Fig 3.5), the estimator can 

be of the form: 

 () () ()
() ()

() ()fXfX

fXfY
Htxtxtyty e

N

i

i

N

i

i *

*

11

,)(,)( === ää
==

w     

 

This type of averaging is called the time domain synchronous averaging. This estimator reduces the 

system random noise, but it can't reduce nonlinear distortions and the stationary noise that is periodic 

within the excitation period. 

 

 

Figure 3.5 Illustration of the signal generation and acquisition during the time domain synchronous 

averaging process 

 

The quality of the frequency response estimation is noise dependent as follows: 

1. The noise influence is high at frequencies near fs/2, where we miss the excitation energy, 

which is filtered with a D/A smoothing filter.  The problem is solved in the ARTA by digital 

filtering the estimated impulse response at frequency lower than converter's antialiasing filter 

cut-off frequency. 

2. The noise influence is also high at extremely low frequencies, as system is AC coupled. This 

implies that soundcards with very low cut-off frequency have to be used. 

 

In acoustical measurements the period of the multisine must be greater than the reverberation time - 

T60 .  The following reasoning can approve this requirement. The room acoustical response has the 

bandwidth of resonance peaks equal to 2.2/T60. If we choose that the frequency difference between two 

multisine component is less than half of this value, to allow build up of all room resonances, we can 

conclude that period of the periodic noise have to be equal or greater than the reverberation time. Also, 

it follows that length of the preaveraging cycle must be greater or equal to the reverberation time.  
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3.4 Single Channel System for Frequency Response Estimation 
 

In a single channel system, only the output signal from a D.U.T is measured.  Excitation signal is not 

measured at the input of a D.U.T, rather it is assumed to be the known signal g that is generated in the 

computer memory. Block schematic of the measurement system is shown in Fig. 3.6.  

 

 

 
Figure 3.6 Block schematic of the  single channel measurement system (D ï digital to analog 

converter, A-analog to digital converter, g ï generated discrete signal) 

 

 

The estimated frequency response He  is the ratio of the cross-spectrum YG*  and the auto-spectrum 

GG*:  
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In the best case, i.e. with no noise present, we get: 

 

()()()fDfAfHfHe =)(  

 

We see that the estimated frequency response is always biased with transfer functions of A/D and D/A 

converters. It is not a bad thing, as might be concluded at first, because this way we get the good S/N 

ratio at extreme low and high frequencies (A/D and D/A converters filters out spectrum at low 

frequencies and near fs/2). This is especially important if we use cheap soundcards that might have a 

high the low frequency cut-off. 

 

Theoretically, the averaging technique, from a dual channel system, can be applied to a single channel 

system, but due to limitation of the Windows sound driver, which does not keep the synchronicity 

between the signal playback and recording, only the time domain synchronous averaging can be 

applied.  The phase response can't be estimated with an absolute accuracy. 

 

To conclude:  

 

The single channel system is recommended as a measurement system when we use the low quality 

sound cards. It is suitable for the measurement of the frequency response magnitude, but it does 

not give the accurate absolute phase response.  

 

If we want to use the microphone channel of the soundcard, then we can only apply a single 

channel system, as the microphone input on all soundcards is monophonic.  
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4 Real-time Frequency Response Measurement 

 

4.1 User Interface for Real-Time Measurement of Frequency 
Response  
 

The real-time measurement of the frequency response can be controlled from two windows: 

 

FR2   Dual channel frequency response window  

FR1   Single channel frequency response window 

 

Both windows have the same form of the user interface, with following functional differences: 

 

1. In a single channel mode the excitation signal have to be the periodic noise, while in a dual 

channel mode the excitation signal can also be the continuous noise.  

2. In a single channel mode only the magnitude of the frequency response is shown, while in a 

dual channel mode the phase response and the coherence function can also be shown. 

 

Measurements are controlled by menu commands, dialogs, toolbar icons (Fig. 4.1) and a control bar 

(Fig. 4.2). 

 

 

 
 

Figure 4.1 Frequency response window - toolbar icons  

 

 

 

 
 

Figure 4.2 Frequency response window ï control bar  

 
Control bar has following controls: 

  Gen   - chooses the generator signal type     

  Fs (Hz) - chooses the sampling frequency       

  FFT   - chooses the number of samples in an FFT block   

  Delay (ms)  - enters the delay in the measured system (used only in a dual channel mode) 

  Avg   - chooses the averaging type (None, linear, exponential) 

  Reset   - reset the averaging 

 

 

To make a real-time measurement of the frequency response, following steps are required: 
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1. Enter the single or dual channel frequency response window, and connect the measuring system as 

shown in chapter 1.  

 

2. Activate the 'Audio device setup' dialog box by clicking the menu Setup->Audio devices or by 

clicking the toolbar icon . Use this dialog box to setup soundcard I/O parameters, the voltage 

probe gain, the power amplifier gain (only for 1Ch mode) and the microphone sensitivity (if you use 

the microphone). 

 

3. Activate the 'Signal generator setup' dialog box by clicking the menu Generator->Configure or 

by clicking the toolbar icon . Use this dialog box to choose the type of excitation signal (white 

noise, pink noise, PN white, PN pink). In a single channel mode only the periodic noise excitation (PN 

white or PN pink) is allowed. If you use the PN pink excitation, set the low-frequency cut-off. Also, 

set the soundcard output volume. Note: choice of the generator type is usually done using the control 

bar. 

 

4. Activate the 'Frequency Response Measurement Setup' dialog box by clicking the menu Setup-

>Measurement or by clicking the toolbar icon . This dialog box is shown in Fig. 4.3. 

 

 

 
 

Figure 4.3 Dialog box for the frequency response measurement setup 

 

Dialog box for the measurement setup is used as follows:  

 

FFT resolution section: 

FFT size  - chooses the number of samples in an FFT block.  

Sampling Rate ï chooses the sampling frequency in Hz.   

Window ï chooses the signal window (used only with the continuous noise or an external excitation).   

 

Averaging section: 

Type ï   chooses the averaging type (None, linear, exponential).  

Max averages ï enters the maximum number of averaging.  

 

Measurement config section: 

Preferred input channel ï chooses the soundcard input channel used to measure a D.U.T output.  

Propagation delay ï enters the delay in the measured system (not used in a  1Ch mode). 

Invert Phase of input channel - check box to change the polarity of input signal.  
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Multisine averaging section: 

Preaveraging  - check box to activate the preaveraging cycle (generally, this check box should be 

checked always).   

Frequency domain averaging ï check box to use the frequency domain averaging  (not used in a 1Ch 

mode) .  

In two channel mode show ï chooses the plot setup for a dual channel mode (Magnitude, Magnitude + Phase 

and Magnitude + Coherence or Magnitude + Phase + Coherence) . In a single channel mode a magnitude 

response is plotted only. 

Phase ï   check to enable FR phase plot.  

Coherence ï check to enable FR coherence plot. 

 

 

 

5. Activate the 'Frequency response graph setup' dialog box by clicking the menu Setup->Graph 

setup or by clicking the mouse in the plot area. This dialog box is shown in Fig. 4.4. Use this dialog 

box to adjust (1) dynamic range shown, (2) frequency range shown and (3) frequency axis resolution. 

 

 

 

 
 

Figure 4.4 Frequency response graph setup 

 

Controls in this dialog box are: 

 

Dynamic range section: 

 Graph top (dB) ï enters the level in dB for the top graph margin. 

 Graph r ange (dB) ï enters the graph magnitude range. 

 Fit graph top -  sets the Top (dB) value from the current graph maximum magnitude. 

 

Freq. range (Hz) section: 

High ï enters the highest frequency shown (in Hz). 

 Low ï enters the lowest frequency shown (in Hz). 

View All  ï this button sets Low and High frequencies so to enable the view of all DFT spectrum 

components.  

 

Frequency axis section: 

Type - Four types of the frequency axis resolution are available: 

Linear  ï linear frequency axis, 

Logarithmi c - logarithmic frequency axis, 

Octave smoothing ï logarithmically swept-octave bands, 

Octave bands ï discrete octave bands . 

Smoothing - sets the smoothing resolution to 1/n-octave, where n can be: 1,2,3,6,9,12 and 24. 

The smoothing filter has characteristics of the class I  IEC filter (six pole bandpass Butterworth filter). 

 

 



ARTA User Manual 

 59 

6. Finally, you start the measurement by clicking menu Recorder->Run or by clicking to the toolbar 

icon  . 

During measurements, you can use the Control Bar to change the averaging type, reset averaging, 

change the sampling frequency, and change the type of excitation signal and an FFT size. You can 

also change any plot parameters (dynamic range, frequency range and axis) by activating the 'Graph 

setup'  dialog box (click menu Setup->Graph setup or click right mouse button in the plot area).  

Useful shortcuts to change the top graph magnitude margin are keys "Up" and "Down" and a mouse 

scroll wheel. They "move plot up and down".  
 

7. You can stop measurements any time by clicking the menu Recorder->stop, or by clicking the 

toolbar icon . The measurement duration depends on the type of averaging. If an averaging is not 

used, measurements are repeated until the user stops the recording. If averaging is used, measurements 

stop when the maximum number of averaging cycles is reached or when the user aborts the recording. 

 

4.2 Dynamic Range in Frequency Response Measurements 
 

In the following example, it will be shown how to check available dynamic range while measuring  the 

frequency response in FR1 and FR2 modes.  

 

Start in FR1 mode. Connect soundcard in loopback mode (left and right channel) and set: 

Generator type : Pink PN 

Generator level : 0 dB 

FFT : 32768 

Averaging: None 

 

Start recording of left channel. You will get picture of loopback frequency response as in figure 4.5.  

 

 
 

Figure 4.5 Frequency response of Terratec EWX 24/96 in loopback mode 
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Now disconnect left input channel and measure response. What you measure now is a noise floor of 

the input channel. Make a measurement without the averaging and save measured curve as overlay 

(menu command File->Set as overlay). Then repeat measurement with averaging = 100. 

In both cases set the Frequency axis in 'Frequency Response Graph Setup' to 'Octave smoothed' 

with resolution '1/3 octave'. 

You will get the noise floor curve as in Figure 4.6. Note that absolute level of noise floor actually 

gives us the maximal dynamic range that can be obtained with a soundcard.  

What we see is that averaging reduce a noise floor and increase a dynamic range, but not equally at all 

frequencies.  

 

 
 

Figure 4.6 Dynamic range in FR1 mode for soundcard EWX 24/96, without averaging (upper curve) 

and with averaging (lower curve). 

 

Now connect the right channel in loopback mode and repeat the measurement in FR2 mode. Check the 

óFrequency domain averagingô mode in the óFrequency Response Measurement Setupô dialog. 

You will get almost perfectly flat frequency response and a dynamic range as shown in Figure 4.7. 

 

 
Figure 4.7 Dynamic range in FR2 mode for soundcard EWX 24/96, without averaging (upper curve) 

and with averaging (lower curve) 
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We see that Frequency domain averaging, in FR2 mode, gives slightly larger dynamic range than FR1 

mode. This gain in dynamic range will be more pronounced when measuring systems that exhibit 

nonlinear distortions.  

 

The averaging enables measurements with large dynamic range, but only if we use high quality 

soundcard. The Figure 4.8 shows comparison of noise floor for two souncards (Intel integrated audio 

and very high quality sound system RME Fireface 800). During measurements both cards were in 16-

bit mode but the difference in dynamic range is  30-50dB. 

 
Figure 4.8 Dynamic range in FR1 mode without averaging for Intel Integrated audio (upper curve) 

and RME Fireface 800 (lower curve). 

 
 

Note: Preceding examples show 1/3-octave smoothed curves. The smoothing of 

frequency response curve is done in different way than smoothing of spectrum 

magnitude. The ARTA uses approach to first interpolate and average frequency response 

on log-frequency axis, then makes smoothing by convolving that response with response 

of bandpass 6-pole Butterworth filter. 

  

4.3 FR overlays  
In the Frequency response windows the following menu commands are for overlay's manipulations:  
 

Overlay 

Set overlay  - sets current FR as overlay     
Delete overlay  - removes overlay    
Load   overlay - loads FR overlay file 
Save  overlay -  saves FR in overlay file     

Generate target response - generates overlay with response of standard crossover filters 

Load target response ï loads target response from  ASCII file  
Delete target response ï removes target curve 

Set overlay  - sets current FR as overlay     
Show difference from overlay ï switches to show the difference of magnitude from the overlay level 

 

Here we deal with three types of overlays: 

The first type can be set from the currently plotted curve using the command 'Overlay->Set overlay' 

or load from disk by using the command 'Overlay->Load overlay'. It can be shown only one overlay 

of this type. This type of overlay can be saved to disk using the command 'Overlay->Save overlay'. 

Names of overlay files have an extension '.ovf'. 
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The second type of overlays are user defined target filter responses. They can be generated by using 

dialog box  'Target Filter response' shown in Figure 4.9. It is  activated by the menu command 

'Overlay->Generate target response'.  

 

 

 
  

Figure 4.9 The dialog for generation of an overlay with loudspeaker crossover target filter response 

 

The selection of  target filter responses is from the set of optimal loudspeaker crossover filter 

responses. User chooses the kind of optimal crossover filter in the right list box and sets 

parameters of that filter:  

 
Reference passband sensitivity - an arbitrary value for loudspeaker passband sensitivity 

Filter  Type - low-pass, high-pass, band-pass or cascade of low-pass and high-pass  

Q-factor ï edit box is for entering the second order filter Q-factor 

Crossover frequencies - two edit box are for entering crossover lower and upper  frequencies 

 

The third type of overlays are user defined arbitrary responses loaded from an ASCII file (by menu 

command  'Overlay->Load target response').   

 

The content should be formatted  in well known .frd  format: 
 
* a leading star may be used to denote optional comment  

* frequenc y  magnitude (dB)  

  1000       32  

  1020       33  

  1040       34  

  ....       ...  

 

Optionally, third colon  may contain the value of phase. 
 












































































































































































































